
  

�
�
�
�
�

�������	�
���
and 

����
�����
���
�
�
�
�
�

Add-ins for inserting mathematical 
text, graphs and drawings into 
Microsoft Word for Windows 
Documents and Powerpoint for 
Windows Presentations 



  

�

�

�

�

�

�

�
Disclaimer 

 
This package is disturbed "as is" with no warranty either expressed or 
implied.  When these programs left our computer they were free from any 
viruses, worms, and other harmful software.  However, we are not 
responsible for any effects to your computer, including but not limited to,  
any harmful software that may be attached after they leave our control. 
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EASIWord 
& 

EASIGraph 

EASIWord and EASIGraph integrate seamlessly into 
Microsoft Office converting it into a powerful mathematics 
processor. 

Introduction  

EASIWord and EASIGraph allow the insertion of mathematical 
expressions, graphs and drawings into documents and presentations.  
These expressions, graphs and drawings become a permanent part of 
the document or presentation and can be edited or shared with others. 

EASIWord is available each time that Word is opened.  The way it 
appears on your screen depends on the version of Word that you have 
installed.  In versions of Word prior to 2007, two additional toolbars 
and several keyboards are available.  In versions beginning in 2007, 
an EASIWord Tab is inserted beside the Home Tab on the Ribbon.  In 
either case several mathematical tools are now available.  As an 

example, type x + 1/x + 3 and select it.  Click the  button on the 

EASIWord toolbar and the text changes to the fraction 
x + 1
x + 3.  

EASIWord also includes a mathematics symbol keyboard.  The 
symbols are added into Word simply by clicking on them.  Note that 
some of the functionality described in this manual is slightly different 
if you have a version of Word prior to 2007. 
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 Zoom Tool  

 

The Zoom Tool zooms in on a part of a graph to make more accurate 
drawings. When this tool is selected, zooming is done two different 
ways: the first is to click on a point in the drawing window to zoom to 
that point, and the second is to marquee select a zoom region. To 
marquee select a region, depress and mouse at one corner of the 
region and while still depressed, drag it to the opposite corner and 
release. As closely as possible the graph window zooms to the 
selected region. Since the selected region may not be proportional to 
the drawing window, the zoom region does not exactly match the 
selected region. 

While the Zoom Tool is activated, right clicking in the drawing 
window resets the zoom. 

The drawing window stays at the current zoom level when other tools 
are activated. If the drawing window is zoomed, then  appears in the 
upper right hand corner of the tool frame. Clicking on the button 
zooms the drawing window resets the zoom. 

Clicking on any of the four arrow buttons in the tool window causes 
the zoom location in the drawing window to be moved in the 
corresponding direction. The four arrow keys on the keyboard 
accomplish the same task. 

Many drawing tools allow zooming without selecting the Zoom Tool. 
In these tools a right click in the drawing window zooms to the point 
of the click.
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EASIGraph is a program that runs from inside Word or as a stand-
alone program.  It allows fast creation of mathematical drawings and 
graphs.  These drawings and graphs can be dragged into Word 
documents and can be dragged back to EASIGraph at any time for 
editing. 

The package was written* by Gary A. Seldomridge of Potomac State 
College of West Virginia University. The program is free with no 
money either solicited or accepted. The only restrictions on 
distributing it are: 

·  it must be distributed in its entirety with no modifications to 
the program or any ancillary files 

·  ownership must not be assigned to anyone other than Gary A. 
Seldomridge 

·  no fee can be charged for the program 

 

We hope you enjoy the program and will contact us with any bug 
reports, suggestions for future releases, praise, or criticism at 
gaseldomridge@gmail.com. 

 

*Thanks to Mitchell Durst for his invaluable help in debugging the program. 

Our Logo 

Our logo is a stylized version of the graph of the 

parametric system  
�
�
� x(t) = sin(2t)
y(t) = cos(3t)  .  To create the 

graph,  go to the parametric graph mode and enter 
x(t) = sin(2t), y(t) = cos(3t), a domain of 0 to 2pi 
and user units from -2 to 2. 
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Installation 

EASIWord 4 is available at http://electricabacus.com and is 
distributed as an msi file.  When downloading it from the web, some 
browsers will attempt to change the file to an html file.  See 
information on the web site if your browser is doing this.  Once the 
file is downloaded double click it to begin the installation and follow 
the directions on the screen.  When the program finishes installing, it 
places an icon on the desktop.  At this moment the program has been 
installed but has not been linked with your version of Microsoft 
Word.   

To complete the installation double click on the icon and follow the 
directions given.  In particular, for a version of Word prior to 2007, it 
is necessary to set the security level to Medium or High.  If the 
security level is set to Very High then no macros will be executed and 
EASIWord will not run.  Follow the directions given on the 
installation page to change the security level.  Once the level has been 
set, be sure to close Word before pressing the button to complete the 
installation.  In versions of Word since 2007, no changes need to be 
made to the security levels. 

Sharing Documents 

The documents created by EASIWord are standard documents that 
can be shared with anyone who has a compatible version of Microsoft 
Word.  Documents stored as doc files can be shared with anyone.  
Those stored as docx files can be shared with users of versions of 
Word since 2007.  There is, however, one issue that must be 
addressed.  EASIWord documents potentially use four fonts that may 
not be on the other computer.  These fonts are True Type fonts.  They 
are named MathCh27.ttf, MathCh28.ttf, MCScript.ttf, and 
MCFences.ttf.  You have several options: 

1. These font files are hereby placed in the public domain.  You 
may copy them from your fonts folder and freely distribute 
them 
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This drop box gives the units to be used in dimensioning segments. If 
the value is in then the segment is measured in inches and if it is cm, 
the segment is measured in centimeters. 

Use Actual Size  

 

Applies To: Angle Measure Tool, Dimension Tool. 

If this box is checked, then the Dimension Tool, inserts the length of 
the segment where the dimension information goes. The length is in 
either inches or centimeters depending on the value of the Units box. 
For the Angle Measure Tool, the angle measure of the angle in 
degrees is placed where the dimension information goes. In either 
case the accuracy used is determined by the Decimals value. 

x(t) and y(t)  

 

Applies To Parametric Graph 

The graph x = x(t) and y = y(t) is plotted as a parametric equation. 
Any variable other than t, pi, or e is set equal to 0. For more 
information on the expressions that can be entered in the boxes, see 
Mathematical Expressions. 
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the angle measures are checked, then those angle measures are placed 
inside the angles in the drawing as labels. 

Type of Segment Split  

 

Applies To: Split Segment Tool 

This tool determines the shape used to split the original segment. The 
choices are Point, Hatch, and X. Point places a point at each of the 
split points, Hatch draws a short line perpendicular to the segment, 
and X places a cross symbol. 

Units Options  

 

Applies To: Implicit Graph Tool , Parametric Graph Tool, Polar 
Graph Tool, Rectangular Graph Tool 

There are two values for each of x and y. These represent the values 
of x and y at the left, right, bottom, and top of the graph. The Domain 
values represent the values of the independent variable (either x or t) 
for which the graph is drawn. For rectangular curves, the part of the 
graph that is drawn can be restricted by setting the domain to a subset 
of the values of x. For a polar or parametric curve, the domain gives 
the values of t that are used to draw the curve. The domain is not used 
for implicit curves. 

Units  

 

Applies To: Dimension Tool. 
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2. The person receiving the document can download the fonts 
from electricabacus.com 

3. You can embed the fonts into the document by setting the 
Save As options when saving the file.  This option increases 
the size of the file, but is usually the best choice for 
distributing one document. 

4. You can save the file in pdf format.  This option may not 
allow the recipient to edit the document. 

5. The other user can install EASIWord.  This is our favorite 
option. 

Setting Up Word for Mathematical Word Processing 

Word tends to do many things for you automatically.  For the typical 
user, these features can be wonderful.  But for mathematical word 
procession they can be very annoying.  For example, by default Word 
sometimes changes the capitalization of text.  If you are typing 
variables or symbol, you do not want this to happen.  The changes 
recommended in this section have nothing directly to do with 
EASIWord but with mathematical word processing in general. 

It is highly recommended that you change some of the AutoCorrect 
options.  The way you do this depends on the version of Word you are 
running so you may need to check the help files.   

For Word 14 (the version that ships with Office 2010), 
Right Click on the Ribbon and click on Customize the 
Ribbon.  Click on Proofing and click the AutoCorrect 
Options button.  Select the AutoCorrect Tab.  We suggest 
that you uncheck the follow:  Correct TWo INitial 
CApitals, Capitalize first letter of sentences, Capitalize first 
letter of table cells,  Correct accidental usage of cAPS 
LOCK and Replace text as you type.  In both the 
Autoformat and the Autoformat as you type tabs, uncheck 
the Fractions with fraction character option.  You may also 
want to uncheck the Use smart paragraph selection box 
under Advanced (on the same menu as Proofing). 
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For Word 12 (ships with Office 2007), click the Office 
button and click Word Options.  Click on Proofing and 
click the AutoCorrect Options button.  Select the 
AutoCorrect Tab.  We suggest that you uncheck the follow:  
Correct TWo INitial CApitals, Capitalize first letter of 
sentences, Capitalize first letter of table cells,  Correct 
accidental usage of cAPS LOCK and Replace text as you 
type.  In both the Autoformat and the Autoformat as you 
type tabs, uncheck the Fractions with fraction character 
option.  You may also want to uncheck the Use smart 
paragraph selection box under Advanced (on the same 
menu as Proofing). 
 
For versions of Word prior to 12, click the Tools Menu and 
click on AutoCorrect Options.  We suggest that you 
uncheck the follow:  Correct TWo INitial CApitals, 
Capitalize first letter of sentences, Capitalize first letter of 
table cells,  Correct accidental usage of cAPS LOCK and 
Replace text as you type.  .  In both the Autoformat and the 
Autoformat as you type tabs, uncheck the Fractions with 
fraction character option.  You may also want to uncheck 
the Use smart paragraph selection box under the Edit tab.  
Note that some versions of Word do not have all of these 
options.  If the option is not available, then ignore it. 
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Set the desired properties for the triangle. The way that a triangle is 
drawn depends primarily on the Triangle Type setting. See that tool 
for more information. 

For more information about setting properties for this tool, see: 
Triangle Type, Font Name, Font Size, Line Width , Dotted, Snap, 
Constrain, Auto Label, Fill , Color, Color Picker. 

Triangle Type  

 

Applies To: Triangle Tool 

One of the following options must be selected: Ordinary, Isosceles, 
Equilateral, Right, or Special. 

If Ordinary is selected, then click on the three vertices one at a time. 

If Isosceles is selected click on the two vertices of the base and then 
move the cursor to form an isosceles triangle. Click to accept the 
triangle. 

If Equilateral is selected click on the two vertices of the base and then 
move the cursor to choose one of the two possible equilateral 
triangles. Click to accept it. 

If Right is selected, click on one of the non-right angle vertices, move 
the cursor to the right angle and click again. Move the cursor to form 
a right triangle and click to accept it. 

If Special is selected, then enter two angle measures in the two text 
boxes. The third angle is calculated. If the Expand box is not checked, 
click on the first two vertices and move the cursor to choose one of 
the two options. Click to accept it. If Expand is checked, click on the 
first two vertices. As the cursor is moved for the third angle, the 
triangle expands or contracts to follow the cursor. In either case the 
triangle is drawn with the angles entered. If any of the boxes beside 
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 Trapezoid Tool  

 

Set the desired properties for the trapezoid. If Isosceles is checked, 
then click on the two vertices of one of the parallel sides. Move the 
cursor to choose the trapezoid and click. If Isosceles is not checked, 
then click on the two vertices of one of the parallel sides, click on the 
next vertex in either clockwise or counterclockwise order, and move 
the cursor to choose the trapezoid. Click to accept it. 

For more information about setting properties for this tool, see: 
Isosceles Trapezoid, Line Width , Dotted, Snap, Constrain, Auto 
Label, Font Name, Font Size, Fill , Checkerboard, Color, Color 
Picker. 

 Triangle Tool  
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EASIWord 
Math Tools 

Samples 
 
The following are samples of mathematical text that were typed with 
EASIWord.  The text takes much less time to type than with Equation 
Editor. 
 

x2 + 4
x �  3  lim

h® 0
 
f(x + h) �  f(x)

h  

 
n

�
i=1

 x
2
i  

3
81 

� 
b

a
f(x) dx = lim

n® �
 
b �  a

n  
n

�
i=1

 f(a + i 
b �  a

n )    

 

�
�
�

�
�
	x2 + 4

x2 �� 3

3 AB
¾¾

  �   CD
¾®

 

 

�

�

� x + 2y + 3z = -4
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Shortcut Keys 

Several EASIWord commands have shortcut keys assigned that 
greatly increase the speed that mathematical expressions can be typed.  
These shortcuts are given with the tools in this section.  However, 
there are two convenient  keyboard shortcuts that don’t correspond to 
any tool.  Control Shift (spacebar) inserts a hard space in the 
document.  A hard space appears like any other space, but it does not 
allow line breaks to occur.  Hard spaces are convenient for typing 
polynomials where you don’t want the line to break in the middle.  
Control Shift - inserts a minus symbol (� ).  Note that the minus 
symbol is wider than the hyphen. 

 
 Arc Tool  

This tool places an arc symbol over the selection. If the selection 
contains more than 5 characters an error occurs. If nothing is selected, 
an arc symbol is placed over the previous character. 

 Caret Tool 

This tool places a caret symbol over the selection. If the selection 
contains more than 5 characters an error occurs. If nothing is selected, 
a caret symbol is placed over the previous character. 

 Evaluated Tool 

This tool creates an evaluated symbol used to show where the results 
of a definite integral are evaluated from. Type the lower limit, a /, and 
the upper limit. Select them all and click this button. 

 Exponent Tool 

Shortcut - Control Shift Up Arrow 
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Trace Mode 

This command is found in the File Menu. 

This menu item sets EASIGraph into a mode allowing the user to 
trace drawings. First drag a corner or edge of the drawing window to 
resize it to a convenient size. Often a larger size is better for tracing. 
When the Trace Mode button is pressed, a dialog is opened for 
choosing an image file. This image is rescaled to fit the drawing 
window. The image will remain as in the window as long as the 
program remains in trace mode. Note that each time the program is 
loaded it is set to non-trace mode. The background image can be 
traced using the Freehand Tool and the final result can be saved or 
exported as an object. 

Transforming Tools  

 

·  Moving Tool 
·  Rotate Tool 
·  Resize Tool 
·  Duplicate Tool 
·  Create A Region Tool 
·  Flip Horizontally Tool 
·  Flip Vertically Tool 
·  Space Objects Tool 
·  Align Objects Tool 
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EASIGraph 4 includes nine families of tools: 

·  The Selecting Tools are used to select objects to be modified 
or edited by other tools. 

·  The Graphing Tools are used to plot graphs. 

·  The Drawing Tools are used to draw geometric figures. 

·  The Hatching Tools are used to place hatch marks on the 
sides or angles of geometric figures. 

·  The Line Tools draw special lines such as perpendiculars or 
angle bisectors. A tool is also included to find the point of 
intersection of lines or paths. 

·  The Circle Tools draw special circles; or lines or points 
related to circles. 

·  The Transforming Tools perform tasks such as moving, 
rotating, resizing, or spacing objects. 

·  The Text Tools are used to enter labels or dimensions. These 
entries can contain fractions, exponents or other mathematical 
functions and symbols. 

·  The Editing Tools include tasks such as deleting, cropping, 
or zooming. 
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This tool creates an exponent. Type the exponent. If it consists of one 
character or one field, then click this button or press the shortcut keys. 
If the exponent consists of more than one character, select the 
exponent and click this button or press the shortcut keys. The 
exponent can be moved vertically to fine tune its look by using the 
Move Up and Move Down tools. 

 Fraction Tool 

Shortcut - Control Shift F 

Type the numerator of the fraction, followed by a /, and the 
denominator of the fraction. Select the entire fraction and click this 
button or press the shortcut keys. Note that complex fractions can be 
formed by creating the innermost fractions first. 

 Glue Tool 
 

Sometimes Microsoft Word breaks lines at spaces and field results so 
that part of the mathematical expression is on one line and part is on 
another. The problem with spaces can be eliminated by using "hard" 
spaces (press Control Shift Spacebar). These spaces are displayed as 
any other space, but Word does not break a line at a hard space. To 
circumvent the problem of lines being broken apart at field results, 
use this tool. If an expression is selected and this tool is clicked, then 
the expression is treated as one object and cannot be separated for line 
breaks. 

 Insert Blank Tool 

When this tool is clicked the following window is displayed. 

. Choose an option button for the desired units and enter 
the length of the desired blank line. A blank line is inserted at the 
cursor position of the length chosen. Blanks are particularly 
convenient for fill in the blank problems. 
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 Integral Tool  

Shortcut - Control Shift I 

This tool creates a definite integral. Type the lower limit, a /, and the 
upper limit. Select them all and click this button or press the shortcut 
keys. 

 Left Ray Tool 

This tool places a left ray over the selection. If the selection contains 
more than 5 characters an error occurs. If nothing is selected, a left 
ray is placed over the previous character. 

 Limit Tool  

Shortcut - Control Shift L 

Type the variable, a /, and the value the variable approaches; for 
example, h/0. Select it all and click this button or press the shortcut 
keys.  Our example produces lim

h® 0
. 

 Line Tool 

This tool places a line symbol over the selection. If the selection 
contains more than 5 characters an error occurs. If nothing is selected, 
a line symbol is placed over the previous character. 

 Move Down Tool 

Shortcut - None 

This tool moves a character or field result downward. It can be 
repeatedly applied to accurately place a subscript. 
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·  Subscript  -- Shortcut: Ctrl Shift down arrow. 
Click this button to make the previous text object a subscript. 
If the subscript contains more than one text object, select 
them first then press this button. 

·  Superscript/Subscript  -- Shortcut: none 
Click this button to add both a superscript and a subscript to a 
variable. Enter the superscript followed by a / and the 
subscript. Select them all and click this button. 

·  Overwrite Symbols  -- Shortcut: none. 
These buttons place the symbol on the clicked button over the 
selected characters or previous character if nothing is 
selected. 

·  Parentheses  -- Shortcut: none. 
These buttons place parentheses around or to the left or right 
of the currently selected text. 

Note that all of the functions given above can be nested. For example 
the square root of a fraction can be formed by first creating the 
fraction and then selecting it and pressing the square root key. 

Clicking outside the textbox moves the textbox to the cursor location. 
Right clicking outside the textbox displays a menu giving the options 
of starting a new textbox or moving the current textbox. 

For more information about setting properties for this tool, see: Font 
Name, Font Size, Auto Label, Color Picker. 

Tools  
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selected either by dragging the mouse over it or by holding down the 
Shift key and using the arrow keys on the keyboard. Once text is 
selected the bold button  makes the selected text bold. Similarly the 
Italic button   makes it italic and the Script button  makes the text 
script. 

 The math button opens two sets of tools , math 
function tools and special symbols. The drawing window may need to 
be enlarged (by dragging one edge or corner) to see all of the tools. It 
can be dragged back to its original size when finished. The defaults 
are shown in the image above, but they can be changed using the Edit 
menu. A special symbol can be inserted into the text box by clicking 
on the symbol. The math functions are described below: 

·  Fraction  -- Shortcut: Ctrl Shift F. 
Type the fraction with the numerator and denominator 
separated by a /. Select the entire fraction and press this 
button. 

·  Exponent  -- Shortcut: Ctrl Shift up arrow. 
Click this button to make the previous text object an 
exponent. If the exponent contains more than one text object, 
select them first then press this button. 

·  Square Root  -- Shortcut: Ctrl Shift S. 
Click this button to place the selected text within a square 
root symbol. If no text is selected, the previous text object is 
placed under the radical. 

·  nth Root  -- Shortcut: none. 
To create a root other than a square root, type the radix (for 
example, 3 for cubed root), a /, and then the argument of the 
root. Select them all and click this button. 

·  Limit  -- Shortcut: Ctrl Shift L. 
To create a limit, type the variable, a /, and the number or 
expression that it approaches (for example h/0); select it all 
and click this button. 
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 Move Up Tool 

Shortcut - None 

This tool moves a character or field result upward. It can be 
repeatedly applied to accurately place an exponent. 

 Normal Tool 

Shortcut - Control Shift N 

This tool changes the current font and font size to the values applied 
to the current paragraph. When the cursor is moved using either the 
mouse or the keyboard, Word changes the font to the font of the 
previous character. This tool changes it to the paragraph font.  

 nth Root Tool 

Shortcut - None 

This tool creates an nth root; such as a cubed root or fourth root. Type 
the radix, followed by a slash, and the argument of the root. For 
example, type 3/27. Select the entire expression and click this button. 

The result is 
3

27. 

 Parentheses Tool 

Although this tool can be used to place parentheses around 
standard text, its primary purpose is to place parentheses 
around fractions, matrices or other field results that are 
larger in the vertical direction than standard text. Select the text to be 
placed within the parentheses and click this button. The menu  is 
displayed. In the Type box choose Double to place parentheses 
around the text, or Left or Right to place a single parenthesis on only 
one side. In the right column choose the style of parentheses and click 
OK. 
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 Piecewise Function Tool 

This tool creates a function that is defined piecewise. Type the first 
function followed by a comma and the first condition and another 
comma. Then type the second function followed by a comma and the 
second condition. Continue for as many functions as desired. Select 
them all and click this button. For example, if you type x + 1,x < 2,4,x 
= 2, 2x + 3,x > 2 and select it all and click this button, the result is 

�

�

� x + 1 if x < 2

4 if x = 2
 2x + 3 if x > 2

. 

 Right Ray Tool 

This tool places a right ray over the selection. If the selection contains 
more than 5 characters an error occurs. If nothing is selected, a right 
ray is placed over the previous character. 

 Script Tool 

Shortcut - Control Shift W 

This tool changes the active font to a script font; namely MCScript.ttf. 
It can be applied to a selection or it can be applied at the selection 
point to change future text. 

 Segment Tool 

This tool places a segment symbol over the selection. If the selection 
contains more than 5 characters an error occurs. If nothing is selected, 
a segment symbol is placed over the previous character. 

 Sequence Tool 

Type the variable for the sequence followed by a /. Type the index for 
the sequence followed by another /. Type the upper limit for the 
sequence, select all of the text and click this button. For example, 

typing x/i/10, selecting it, and clicking this button results in {xi}
10
i=1. 

 Page 92 

Text Object  

A text object is a unit of text that cannot be divided into smaller units. 
It is either a single character or the result of a function (such as a 
square root or fraction). 

Text Tools  

 

·  Text Tool 
·  Dimension Tool 
·  Angle Measure Tool 

 Text Tool  

 

When this tool is activated, the cursor changes to a cross symbol with 
a small blue box. The center of the cross represents the upper left 
hand corner of where the text is located in the drawing window. The 
first character of the text is placed inside the blue box. The behavior 
of the command is different depending on whether Auto Label is 
enabled and checked. For information see Auto Label. 

If Auto Label is not enabled and checked, then when the 
mouse is clicked in the drawing window, the cursor is replaced with a 
text box and the menu shown above. Text typed into the box can be 



 Page 91 

For more information about setting properties for this tool, see: 
Number of Sides, Line Width , Dotted, Snap, Constrain, Fixed 
Length, Auto Label, Font Name, Font Size, Fill , Color, Color 
Picker. 

Start Arrow   

 

Applies To: Angle From Tool, Angle To Tool, Drop Perpendicular 
Tool, External Tangents Tool, Freehand Tool, Internal Tangents 
Tool, Line Tool, Tangents Tool. 

If checked then an arrow head is placed at the start of the segment or 
path. 

  Tangents Tool  

 

Select a point and a circle. Select the desired properties for the 
tangent lines. Click Apply  and the tangent lines become permanent. 
Note that both tangents are drawn, but one can be selected and 
deleted. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Start Arrow , End Arrow , Extend By, Color, Color 
Picker. 
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 Simultaneous Equations Tool 

To create a system of simultaneous equations, type the variables 
separated by commas and followed by a /. Type the coefficients and 
constants separated by commas. If a coefficient is negative, it is 
displayed as minus. If a coefficient is zero, the term will be omitted. 
Select all of the text and click this button. For example, typing 
x,y,z/1,2,-3,4,5,-6,7,8,9,0,1,2, selecting it and clicking this button 

results in 
�

�

� x + 2y �  3z = 4
5x �  6y + 7z = 8
9x  + z = 2

. 

 Square Root Tool 

Shortcut - Control Shift R 

This tool creates a square root. Type the argument for the square root. 
If it consists of one character or one field, then click this button or 
press the shortcut keys to place the argument under a radical. If it 
consists of more than one character or field select the argument first. 

 Summation Tool 

Shortcut - Control Shift S 

Type the value that goes under the summation, followed by a /, and 
the value that goes over the summation; for example, n = 1/10. Select 
them all and click this button or press the shortcut keys.  The result is 
10

�
n = 1

. 

 Superscript_Subscript Tool 

Shortcut - None 

This tool places both a superscript and subscript over a variable. The 
superscript and subscript are aligned vertically with each other. Type 
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the superscript, followed by a /, and the subscript. Select them all and 
click this button. 

 Undo Tool 

Most EASIWord math tools can be undone by clicking this button. 
The expression(s) to be undone must be selected and if commands 
have been nested only the last command is undone. 

 Vector Tool 

This tool places a vector symbol (or right ray) over the selection. If 
the selection contains more than 5 characters an error occurs. If 
nothing is selected, a left ray is placed over the previous character. 

 

 Vertical Arithmetic Tool  

This tool allows the four basic arithmetic operations to be entered in a 
more traditional format. All of these problems are placed in a text 
box. 

·  Addition: Type an A followed by the addends separated by 
commas. Select them all and click this button. The sum is 
written in vertical format. A space is left for the sum to be 
typed if desired. 

·  Subtraction: Type an S followed by a number, a comma and 
the number to be subtracted from the first number. Select 
them all and click this button. The subtraction problem is 
written in vertical format. A space is left for the difference to 
be typed if desired. 

·  Type an M followed by a number, a comma, and a second 
number. Select them all and click this button. The 
multiplication problem is written in vertical format. 

·  Type a D followed by the divisor, a comma, and the dividend. 
The problem is written in long division format. 

 Page 90 

 Split Segment Tool  

 

Set the desired properties for the hatch marks. Click on each end of 
the segment in the drawing window. Hatch marks are placed on the 
segment so that the segment is broken into the number of parts given 
in the Number Parts box. Note that the hatch marks can be replaced 
with x's or points by changing the setting of the Type box. 

For more information about setting properties for this tool, see: 
Number of Segments, Type of Segment Split, Line Width , 
HatchSize, Plot Endpoints, Snap, Color, Color Picker. 

 Star Tool  

 

Select the desired properties for the star. Click on the center of the star 
and move the cursor until the desired star is formed. Click to accept it. 



 Page 89 

Every drawing object has snap points. For example, on a circle it is 
its center, on a line segment they are the endpoints, and on a polygon 
they are the vertices. If this box is checked, then every click close to a 
snap point, is moved to the snap point. Normally the cursor for a 

drawing object is   but when the cursor is close to a snap point it 
changes to . This is a powerful feature allowing the precise 
alignment of objects and should normally be left checked. 

 Space Objects Tool  

 

This tool equally spaces selected objects. If the Left button is 
checked, then each selected object is moved horizontally so that the 
space between the left most edges is equal. Similarly, Right spaces the 
right most point of all objects and Center spaces the center of all 
objects. 

Vertical spacing works similarly. 
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EASIWord  

Control Tools 

 

 Capture 

Many programs that do not allow for mathematical functions, symbols 
or drawings accept bitmaps. This tool captures a rectangular region of 
the screen as a bitmap file. When the button is clicked, the cursor is 
changed to a hand with a pencil. Drag the cursor around any 
rectangular region of the screen and a bitmap image of the region is 
placed on the Windows Clipboard. The image can be pasted into any 
program that accepts bmp files. 

 Keyboard Toggle 

EASIWord ships with several keyboards. In addition a doc file named 
MakeKeyboard.doc is included. This doc file includes macros that 
allow the user to create additional keyboards. This command toggles 
the selected keyboards to visible or invisible. The keyboards that are 
toggled on and off depend on which ones are selected with the 
Keyboard Setup command. The buttons available on the keyboards 
enter special symbols into a Word document. Some of the buttons 
have a small red dot in the lower left corner. These buttons surround 
the special symbol with hard spaces. 

Launch EASIGraph  

This tool launches EASIGraph. EASIGraph makes it easy to insert 
mathematical drawings and graphs into Word documents.. 
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Main Setup 

This tool allows the setup of the relative size and position used by 
several of the other tools.  Move the slider to set the values. 

The Normal Font values are used to set the values used when the user 
clicks the Normal button.  The Normal Style button sets the values to 
those of the Normal Style.  If the Always use Selection style box is 
checked, then the values given here are ignored and the values are set 
to the current selection style. 

 Reset Font 

Exponents are normally printed at a smaller font size than standard 
text. If text is selected containing both exponents and standard text, 
and the font size is changed, then the exponents may be formatted 
with the same font size as the text and there vertical positioning may 
not be changed. This is usually not desirable. This tool resizes text 
while maintaining appropriate size and vertical position. It also allows 
fonts to be changed without changing 
symbol fonts.  When the button is 
clicked, the following menu is displayed.. 
The first option under Font Size increases 
all font sizes by the same percentage. If 
the percentage is negative, then all font 
sizes are decreased. The second option 
changes all fonts of a given size to 
another size. For example, if the first text 
box is 10 and the second is 12, then all 10 
point font sizes are changed to 12 and all other font sizes are also 
increased by 20%. The third option increases (or decreases if 
negative) all font sizes by the same amount.  If the Convert Fonts to 
box is checked, then all non-symbol fonts in the selection are changed 
to the font chosen.   
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If this box is checked, then the Dimension Tool, and Angle Measure 
Tool get the dimension label from the Simple Label Text Box. See 
either of these tools for more information. The B and I check boxes 
determine if the label is Bold or Italic. 

Snap Points  

Drawing objects have snap points. The following list gives their 
locations: 

  line both endpoints 
 circle the center of the circle 
 circular arc the center of the circle and both 

endpoints 
 point the center of the point 
 polygon every vertex 
 ellipse the center, top most point, bottom 

most point, left most point and 
right most point (before any 
transformations are applied) 

 elliptical arc the center and both endpoints 
 star all vertex points 
 freehand path the first and last point plotted 

Snap  

 

Applies To: 3 Point Circle Tool, Angle Bisector Tool, Angle From 
Tool, Angle Hatching Tool, Angle Measure Tool, Angle To Tool, 
Circle Tool, Circular Arc Tool , Dimension Tool, Drop 
Perpendicular Tool, Ellipse Tool, Elliptical Arc Tool , Freehand 
Tool, Inscribed Circle Tool, Line Tool, Line Hatching Tool, Node 
Tool, Move Tool, Parallelogram Tool, Perpendicular Bisector 
Tool, Point Tool, Polygon Tool, Right Angle Hatching Tool, 
Rotate Tool, Split Segment Tool, Star Tool, Trapezoid Tool, 
Triangle Tool. 
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objects in the drawing window, F3 deselects all objects in the drawing 
window, and F4 selects the last object added to the drawing window 
(this tool does not change the selection status of previously selected 
objects. If the cursor is over an object in the drawing window, some 
tools display the words "Spacebar Select" shown in red in the lower 
right hand corner of the tool frame, the object can be selected by 
pressing the spacebar on the Keyboard. 

Set Defaults  

 

This command is found in the Edit Menu. 

Defaults are separated into three categories: Miscellaneous Defaults, 
Default Keys, and Default Functions. Miscellaneous defaults change 
the feel of the EASIGraph interface, while Default Keys and Default 
Functions change the keys and functions available for the Text Tool. 

New default settings are implemented only as long as the current 
instance of the program is running so when the program is closed, 
they are lost. To make them permanent, create a profile. 

Show Help  

This command is found in the File Menu. 

When the command is clicked, the checked status is toggled. If the 
item is checked, then brief interactive help is displayed at the bottom 
of the tool menu for each active tool. Anyone other than an expert 
user of EASIGraph, should keep this item checked. 

Simple Label  

 

Applies To: Angle Measure Tool, Dimension Tool. 
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EASIGraph 4.0 
 

Getting Started  

Learning to use any new piece of software can be a daunting task; 
however, this program has been designed to be easy to learn. First 
make sure the Show Help menu item in the File Menu is 
checked. Show Help displays interactive help for each tool. The 
program uses "families" of tools shown on the left of the tool 
window. For each family there are several tools shown across the 
top. 

Beginning users probably will either be graphing rectangular 
graphs or will be drawing simple mathematical figures such as lines 
and circles. Start by drawing a few lines with the Line Tool in the 
Drawing Tools family. Experiment with a few of the other drawing 
tools. Drag these drawings to Microsoft Word (make sure no tools are 
selected on the top row). Draw a Rectangular Graph and put a label 
on it. Eventually you will want to apply transformations to objects 
and to do this you must learn to use the Select Tool. By this time you 
will be proficient at using EASIGraph and the rest of the tools can be 
learned as needed. 

As you make drawings, you will notice that some lines appear to be 
jaggy. This is a result of the pixel resolution of the screen. A 
technique called anti-aliasing can greatly minimize this effect. 
However, it takes considerably longer time to draw the lines and the 
effect can be considerable on complex drawings. We decided that for 
time considerations we would not use anti-aliasing. The lines and 
curves will look smooth when imported into Word or Powerpoint and 
will look smooth when printed. 
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Overview  

EASIGraph can be executed as a stand-alone program or can be called 
directly from EASIWord by clicking the  button in EASIWord. It 
plots graphs and creates mathematical drawings quickly and easily. 
These drawings can be dragged directly into a Word document. They 
can also be dragged back later for editing. The drawings can also be 
exported into a Powerpoint presentation. 

The program is available from ElectricAbacus.com and no money is 
either solicited or accepted. 

Special Keys  

The following are special keys entered from the keyboard: 

Alt Backspace Undoes the most recent command (Same as 
the Undo Button ). 

Arrow Keys If the Move Tool is active, then the selected 
objects are nudged in the direction of the 
arrow. If the Zoom Tool is active, the zoom 
window is moved in the direction of the 
arrow. 

Control For any tool with a Constrain checkbox, 
holding the Control Key down while 
drawing forces the constrain to be active. 
Constrain is active only as long as the 
Control Key is depressed. 

Control D Duplicates the selected objects. 
Control delete Deletes all objects. 
Control H Flips selected objects horizontally 
Control R Refreshes Screen 
Control V Flips selected objects vertically 
Delete Deletes the currently selected objects from 

the drawing window. If done 
unintentionally the Undo button or Alt 
Backspace undo it. 
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deselected; however if the Shift Key is held down, the status of 
previously selected objects is not changed. 

Several tools allow objects to be selected from the Keyboard. 
Whenever the words "Spacebar Select" are visible in red in the lower 
right hand corner of the tool frame, the object can be selected by 
pressing the Space Bar on the Keyboard. 

 When an object is right clicked using the Select Tool, the 
menu shown to the left is displayed. The first option is to edit an 
object. The properties in common to several objects can be edited by 
selecting them first and right clicking on any one of them. See 
Editing Objects for more information. The next four options change 
the front to back order of objects in the drawing. 

The buttons in the tool frame each have a shortcut key shown in 
parentheses below that can be used to perform the same task as 
clicking the button. The buttons perform the following tasks: 

·  Group (F5) -- Groups the selected objects so they are treated 
as one object. 

·  UnGroup (F6) -- Ungroups a group of objects. 

·  Select All (F2) -- Selects all of the objects in the drawing 
window. 

·  Select None (F3) -- Deselects all objects in the drawing 
window. 

·  Select Last (F4) -- Selects the last object added to the drawing 
window (this tool does not change the selection status of 
previously selected objects). 

Selecting Objects  

There are multiple ways to select objects. One way is to use the Select 
Tool. A second way is to use shortcut keys. F2 selects all of the 
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Select Tools  

 

·  Selection Tool 
·  Node Tool 

 Select Tool  

 

Some tools require that objects be selected before applying the tool. 
This tool has two primary purposes: selecting objects in the drawing 
window and editing objects. 

If this tool is enabled, an object can be selected by clicking on the 
object. When the cursor is directly over an object the color of the 
object changes to this color . When clicking on an object, it 
becomes selected and all previously selected objects become 
deselected. However, if the Shift key is held down while clicking on 
an object, it becomes selected without changing the status of 
previously selected objects, allowing the selection of multiple objects. 
Selected objects blink. 

To select multiple objects at one time, marquee select them. To 
marquee select objects, press the mouse button at some point in the 
drawing window. While the button remains down, drag it to another 
corner and release it. A red dotted box is formed. Every object 
completely in the red box is selected. Normally all other objects are 
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END Ends a freehand drawing. It can also be 
ended by right clicking on the last node. 

ESC Cancels a tool. The tool remains active but 
any previous mouse clicks are ignored. 

F1 Displays help for the currently selected tool 
F2 Selects all objects in the drawing window 
F3 Deselects all objects in the drawing window 
F4 Selects the last object drawn in the drawing 

window (does not change the selection 
status of previous objects) 

F5 Groups all selected objects in the drawing 
window 

F6 Ungroups any selected groups 
Shift When the Select Tool is active, holding 

down the Shift key while selecting an 
object causes the selection status of other 
objects to not change (normally they are 
deselected). This adds to a selection. 

Spacebar When this image   is visible, the 
spacebar selects the object under the cursor. 
The selection status of previously selected 
objects is not changed. 

Special Buttons  

Some of the buttons are visible only when the cursor is in certain 
positions on the form. 

 Undo Undoes the last command. Can be 
repeated to undo several commands. 

 Redo Redoes the last command that was 
undone with the Undo command. 

 Minimize Minimizes the program and places it to 
the left side of the screen. Double click 
on the minimized version to bring it 
back to its original size. 
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Paper Color Changes the color of the background. 

Note that the purpose is to show how 
the image appears with the given 
background and does not change the 
image in any way  If the paper is right 
clicked, then the paper changes to 
white. 

 Color Picker Captures a color on the screen. See 
Color Picker for more information. 

 Reset Resets all options for the current tool to 
their default value. See Reset Button 
for more information. 

Menus  

 

EASIGraph 4.0 contains three menus: File Menu, Edit Menu and 
Help Menu. 

Editing Objects  

This topic should not be confused with Edit Tools. Edit Tools deals 
with tasks such as cutting, copying, pasting, and cropping. This topic 
deals with changing the properties of objects. 

When an object is created, several properties are set (for example, 
Color and Line Width ). This tool modifies these properties. When 

the Select Tool is active and an object is right clicked, 
this menu  is displayed. Click on Edit, and all of the 
current object's properties are shown in the tool frame. 
Any changes are applied immediately. If the current 
object is selected, then only properties in common to 
all of the selected objects are shown in the tool frame. 
Any changes are applied to all selected objects. If the 

current object is part of a group, only the properties that are in 
common to all objects in the group are shown and applied to the entire 
group. The other four options in the menu change the order the 
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automatically loaded. Saving a profile with this name containing the 
attributes used most often causes them to be the default settings. 

Save  

This command is found in the File Menu. 

Normally there is no reason to save an EASIGraph drawing. Once the 
drawing is dragged or pasted into a Word document, it is saved with 
the Word document and can be dragged or pasted back into 
EASIGraph for editing at any time. However for complex drawings, it 
may be convenient to save the drawing before finishing it. This 
command saves the file in a format that can be read with the Open 
command in the File Menu. 

Scale Like Selected  

 

Applies To: Implicit Graph Tool , Parametric Graph Tool, Polar 
Graph Tool, Rectangular Graph Tool 

This tool is enabled only if there is either exactly one graph selected 
or all graphs that are selected have the same User Units. 

The tool is used to draw multiple graphs overlapping each other. It is 
also used to plot points on a graph. If the Scale Like Selected box is 
checked, then the new graph (or point) is given the same Graph Size, 
User Units, and position as the selected graph. To make sure graphs 
move together, group them. 

To make a piecewise function, define the function for one piece on a 
graph that contains all of the Axes and User Units information. Set 
the Domain values to restrict the domain to that one piece. Then 
select the graph. For each of the other pieces, make sure that Scale 
Like Selected is checked and restrict the domain in the User Units 
sections. When finished it is sometimes desirable to group all of the 
parts. 
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For more information about setting properties for this tool, see: Line 
Width , Hatch Size, Snap, Color, Color Picker. 

 Rotate Tool  

 

Only selected objects can be rotated. When this tool is chosen the 
cursor changes to this shape . If the cursor is over a snap point, it 
changes to this shape . Begin by clicking on the point in the 
drawing window around which the selected objects are to be rotated. 
This point is called the anchor. Move the cursor to rotate the objects 
and click when they are in the desired position. If the Constrain box is 
checked, then the angle rotated is rounded to a multiple of the angle 
given. 

Save Profile  

This command is found in the Edit Menu. 

The tool saves the current tool settings and defaults. For example, it 
may be desirable to have tools set to wider line widths and different 
colors for a graph being inserted into a Powerpoint presentation than 
one being inserted into Word. Set all of the values desired for 
Powerpoint and save a profile named Powerpoint. Then when that 
profile is opened, all of the settings are updated. Note that changing 
the profile does not change attributes of objects already drawn. 

Every time EASIGraph loads it checks to see if there is a profile 
named "Defaults" stored in the default folder. If there is then it is 
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objects are drawn and thus, change which objects are in the 
foreground and which are in the background. 
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The dialog is not shown again. 

Rename All Files If a new file has the same name as an existing 
file, then the new file name has a number 
appended to it and both files are kept. The 
dialog is not shown again. 

 

Overwrite This File The current file is overwritten with the new 
file and this same dialog is displayed the next 
time a file with the same name exists. 

 

Keep This File The file is kept and the new file is ignored. 
This same dialog is displayed the next time a 
file with the same name exists. 

 

 

 Right Angle Hatching Tool  

 

Set the desired properties for the right angle hatch mark. Click on the 
vertex of the right angle to be hatched. Click on any point on the ray 
forming the leading edge of the angle. Move the mouse and click on a 
point on the terminating edge of the angle. The hatch mark is drawn 
counterclockwise from the beginning ray to the ending ray. 

Note that the right angle hatch can be used for angles of measure not 
equal to 90 degrees to give the illusion of 3D angles. 
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 Reset Button 

For some tools, this button is visible in the lower right hand corner of 
the tool frame.  When clicked it resets all options for the current tool 
to their default value. Note that if there is a profile active then the 
values are set to those in the profile; otherwise the values are set to the 
original values assigned by the program.  

 Resize  

Objects must be selected in order to be resized. When this tool is 
implemented the shape shown to the left is placed around all of the 
selected objects. By dragging any of the larger red squares the size of 
the object is changed proportionally (that is; keeping the ratio of the 
height to the width constant). By dragging any of the smaller squares 
only the dimension of the object in the direction of the square is 
changed; making the objects wider, narrower, taller or shorter. 

Retrieve Collection  

This command is found in the File Menu. 

The command is used to read a collection of objects that are available 
to the Import Objects Menu. These collections can be downloaded 
from electricabacus.com or can be given to you by someone else. 

When the open dialog is displayed, choose the ewc file to be 
retrieved. If a file is being imported with the same name as a file that 
already exists, then a menu is displayed with the options:  

Keep All Files All of the original files are retained and new 
files with the same name are ignored. The 
dialog is not shown again. 

 

Overwrite All Files Any new file with the same name as an 
existing file is overwritten with then new file. 
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EASIGraph Tools 
 

 3 Point Circle Tool  

 

Set the desired properties for the circle. Click on 3 points in the 
drawing window. The circle containing these three points is drawn. 
Note that if Center Only is checked, the circle is not drawn and only 
the center of the circle is plotted. 

For more information about setting properties for this tool, see: Plot 
Center Only, Line Width , Dotted, Snap, Fill , Keep, Color, Color 
Picker. 

 Align Objects Tool  
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This tool aligns selected objects. If the Left option is checked, then 
each selected object is moved horizontally so that the left edge of each 
object is at the left most edge of the entire selection. Similarly, Right 
aligns the right most edge of each object and Center aligns the center 
of each object. The changes are not permanent until the Apply  button 
is pressed. 

Vertical alignment works similarly. 

 Angle Bisector Tool  

 

Select the desired properties for the angle bisector. Click on the vertex 
of the angle to be bisected. Click on any point on the ray forming the 
leading edge of the angle. Move the mouse and click on a point on the 
terminating edge of the angle. The angle to be bisected is from the 
leading edge to the terminating edge in the counterclockwise direction 
unless the Clockwise box is checked. Move the cursor to select the 
length of the angle bisector and click. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Snap, Clockwise, End Arrow , Fixed Length, 
Color, Color Picker. 
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For more information about setting properties for this tool, see: 
Graph Size, f(x), Auto Scale, Asymptotes, Line Width , Color, 
Units Options, Scale Like Selected, Color Picker, Apply . 

Region Options  

 

Applies To: Make Region Tool 

When two or more paths intersect, they may form multiple regions. 
The Make Region Tool creates a new path made up of one of the 
regions formed. 

All paths have an orientation. For polynomials, circles and ellipses it 
is counterclockwise. For arcs it is counterclockwise unless the 
Clockwise option was selected. For line segments and freehand 
drawings, it is in the order in which they were drawn. When the Make 
Region Tool examines a point of intersection between two paths, it 
chooses the first path that is in a positive orientation unless the 
Negative option is selected. If there are two or more possible paths in 
the correct orientation, it chooses the longest path unless the Shortest 
option is selected. 

Regular Polygon  

 

Applies To: Polygon Tool 

If Regular is checked, then the polygon is drawn with all of its sides 
of equal length; otherwise, the polygon is drawn with the plotted 
vertices. 
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expressions that can be used for the function, see Mathematical 
Expressions. 

 Rectangular Graph  

 

This tool plots a graph in rectangular coordinates. The Width and 
Height Fields are set automatically and rarely need to be changed. 
The position of the graph in the graphing window is set by the 
program and cannot be changed. However, once plotted, the graph 
can be Moved, Rotated, or Resized. 

The most important fields to set are the function field, the User 
Units, and the Axes values. 

When changes are made, they are shown immediately in the graphing 
window. However, they do not become a permanent part of the 
drawing until the Apply  button is pressed. When changes are made 
but not yet applied, the background of the tools frame turns this color 

. 

Several graphs can be overlapped. This not only allows multiple 
graphs on the same axes, but allows the graphing of piecewise defined 
functions. The best way to do this is to add all of the axes and user 
unit  information to one graph and select it. Then for each additional 
graph, check the Scale Like Selected box. 
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 Angle From Tool  

 

Set the desired properties for the segment; in particular, set the value 
of the Line Angle. Click on the baseline at the vertex and then click 
on another point on the baseline. Move the cursor to select the desired 
length and click. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Start Arrow , End Arrow , Snap, Line To Angle, 
Fixed Length, Color, Color Picker. 

 Angle Hatching Tool  

 

Set the desired properties for the hatch marks. Click on the vertex of 
the angle to be hatched. Click on any point on the ray forming the 
leading edge of the angle. Move the mouse and click on a point on the 
terminating edge of the angle. The hatch marks are drawn 
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counterclockwise from the beginning ray to the ending ray unless the 
Clockwise box is checked. 

The primary purpose of angle hatch marks is to denote that two angles 
are congruent. 

For more information about setting properties for this tool, see: Line 
Width , Snap, Clockwise, Hatch Size, Number of Hatches, Color, 
Color Picker. 

 Angle Measure Tool  

 

This tool dimensions an angle. The dimension can be the measure of 
the angle, the name of the angle, or any label. The implementation of 
the tool varies depending on whether the Use Actual Size box or 
Simple Label box is checked. 

If Use Actual Size is checked then: 

Set the desired properties for the dimension information. In 
particular set the Attach Degree Symbol box and the 
Decimals box. Click on the vertex of the angle to be 
dimensioned. Move the cursor to a point on the leading ray of 
the angle and click. Move the cursor to a point on the 
terminating ray of the angle and click again. The angle is 
dimensioned with its size in degrees. The Decimals setting 
gives the number of decimal places used to measure the angle. 
If Attach Degree Symbol is checked, then a degree symbol is 
attached to the angle measure. 
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 Polygon Tool  

 

Set the desired properties for the polygon. If the Regular checkbox is 
checked, then click on two adjacent vertices of the polygon. If the 
Regular checkbox is not checked, then click on all of the vertices of 
the polygon in consecutive order. Terminate the drawing by either 
right clicking on the last vertex or by pressing the END button after 
clicking on the last vertex. 

For more information about setting properties for this tool, see: 
Regular Polygon, Number of Sides, Line Width , Dotted, Snap, 
Constrain, Fixed Length, Auto Label, Font Name, Font Size, Fill , 
Color, Color Picker. 

Polygons  

Polygons consist of triangles, parallelograms, trapezoids, standard 
polygons, and stars. 

r(t)   

 

Applies To: Polar Graph 

The graph of r = f(t) is plotted in polar coordinates. Note that t is used 
instead of the Greek letter theta to allow easier keyboard entry. Any 
variable other than t, pi, or e is set equal to 0. For more information on 
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 Polar Graph  

 

This tool plots a graph in polar coordinates. The Width and Height 
Fields are set automatically and rarely need to be changed. The 
position of the graph in the graphing window is set by the program 
and cannot be changed. Once poltted, however, the graph can be 
Moved, Rotated, or Resized. 

The most important fields to set are the function field, the User 
Units, and the Axes values. 

When changes are made, they are shown immediately in the graphing 
window. However, they do not become a permanent part of the 
drawing until the Apply  button is pressed. When changes are made 
but not yet applied, the background of the tools frame turns this color 

. 

Several graphs can be overlapped. This not only allows multiple 
graphs on the same axes, but allows the graphing of piecewise defined 
functions. The best way to do this is to add all of the axes and user 
unit  information to one graph and select it. Then for each additional 
graph, check the Scale Like Selected box. 

For more information about setting properties for this tool, see: 
Graph Size, r(t) , Line Width , Color, Units Options, Scale Like 
Selected, Color Picker, Apply . 
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If Simple Label is checked then: 

Type a label in the Simple Label text box. That label is used 
for the dimension information. The dimension can be made 
Bold, Italic or both by clicking the B or I checkboxes. This 
method is not as flexible as the next method, however; it does 
allow the entry of special symbols. If any of the keywords 
[alpha], [beta], [degree], [delta], [epsilon], [gamma], [mu], 
[phi], [pi], [rho], [sigma], or [theta] is found in the text then it 
is replace with the corresponding Greek letter or symbol. 

If neither Use Actual Size nor Simple Label is checked then: 

Type a label to be placed in the dimension information. This is 
usually a single letter. Select the label (and nothing else). 
Activate this tool and set the desired properties for the 
dimension information. Click on the vertex of the angle to be 
dimensioned. Move the cursor to a point on the leading ray of 
the angle and click. Move the cursor to a point on the 
terminating ray of the angle and click again. The selected label 
moves so that it is the dimension information for the angle. 

For more information about setting properties for this tool, see: Snap, 
Attach Degree, Simple Label, Use Actual Size, Decimal Places, 
Font Name, Font Size, Color, Color Picker. 

 Angle To Tool  

 

Set the desired properties for the segment; in particular, set the value 
of the Line Angle. Click on a point and then click on each of the 
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endpoints of a segment. A segment is drawn from the point to the 
chosen segment at the angle specified. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Start Arrow , End Arrow , Snap, Line To Angle, 
Color, Color Picker. 

Apply To All   

This command is found in the Edit Menu. 

This menu item toggles a checkmark. If checked, then when changes 
are made to a tool, the changes are applied to all objects having the 
given property. For example, if a Color value is changed and this item 
is checked, then all tools having a Color value are changed to the new 
value. Note that this has no effect on objects already drawn. 

Apply   

 

Applies To: Align Objects Tool, Crop Tool, External Tangents 
Tool, Find Intersection Tool, Internal Tangents Tool, Make 
Region Tool, Plot Points, Scale Like Selected, Space Objects Tool, 
Tangents Tool. 

Some tools do not cause permanent changes in the drawing until the 
Apply button is pressed. Whenever a change has been made using one 
of these tools but has not yet been made a permanent part of the 
drawing, the background of the tool's frame turns this color . If 
another tool is activated before applying these changes, then the 
"Keep the Active Graph" dialog is displayed. If Yes is clicked, the 
changes are saved just as if the Apply button had been clicked. 

Arrows   
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To use this tool, either exactly one graph must be selected or multiple 
graphs with the same scale settings must be selected. The tool plots 
points on the selected graph. 

For more information about setting properties for this tool, see: Plot x 
and y, Color Picker. 

Plot x and y  

 

Applies To: Plot Points 

In order to use this tool, exactly one graph must be selected or 
multiple graphs with the same scale settings must be selected. The 
point is plotted on the graph. 

 Point Tool  

 

Set the desired color for the point. Then click in the drawing window. 
The point is placed at the cursor location. 

For more information about setting properties for this tool, see: Snap, 
Color, Color Picker. 
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For more information about setting properties for this tool, see: Line 
Width , Dotted, Snap, End Arrow , Fixed Length, Extend By, 
Color, Color Picker. 

Plot Center Only  

 

Applies To: 3 Point Circle Tool, Inscribed Circle Tool. 

Normally the 3 Point Circle Tool and the Inscribed Circle Tool, draw 
a circle. If this box is checked, then the center of the desired circle is 
plotted and the circle is not drawn. 

Plot Endpoints  

 

Applies To: Split Segment Tool 

Normally the Split Type symbol is placed only in the interior of the 
segment. If this box is checked then the split type symbol is also 
placed at each endpoint of the segment. 

 Plot Points  
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Applies To the Axes Frame of: Implicit Graph Tool , Parametric 
Graph Tool, Polar Graph Tool, Rectangular Graph Tool 

Clicking on the Arrows icon toggles through the various possibilities 
for the type of arrows to be drawn on the axes for the graph. 

Asymptotes  

 

If the Asymptotes box is checked, then each vertical asymptote in the 
domain of the function is plotted as a dotted line. The Asymptotes 
Tool is available only for Rectangular Graphs. 

Attach Degree  

 

Applies To: Angle Measure Tool. 

If this value is checked, then a degree symbol is attached to the angle 
measure or label. 

Auto Crop   

This command is found in the File Menu. 

Clicking this menu item toggles on and off a check mark. If this 
option is checked, then any drawing that is copied to the clipboard or 
dragged to a Word document is automatically cropped to place a 
uniform amount of white space around it. See the Crop Tool for more 
information. Note that this command does not change the size of the 
drawing window, and affects only the way the drawing is displayed in 
Word. It is recommended that the menu item normally be left 
checked. 
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Auto Label  

 

Applies To: Parallelogram Tool, Polygon Tool, Star Tool, 
Trapezoid Tool, Triangle Tool. Text Tool 

Auto Label behaves differently when applied to a polygon or a text 
object. 

As applied to a polygon: 

Entering a single alphabetical character in the AutoLabel 
text box and checking this box automatically labels the 
vertices of the current drawing object. The first vertex 
drawn is labeled with the letter in the Auto Label text box 
and subsequent vertices are labeled with consecutive 
letters. Only letters can be entered in the box with all 
other symbols ignored. Once the letter Z is used, the 
labels cycle back to A. 

As applied to a text object: 

When a label consisting of exactly one alphanumeric 
character (a letter or a number) is created using the Text 
Tool and this box is checked, the tool enters Auto Label 
mode. This mode is denoted by changing the background 
of the tool frame to red. The cursor changes to this shape 

  where the character in the box is given in the Next 
Label box in the tool frame. If the character in the Next 
Label box is changed, the character in the cursor also 
changes. Clicking the cursor at any point in the drawing 
window causes the character to be placed at that location 
and the Next Label box to be increment. When finished 
placing labels, either uncheck the Auto Label box or 
click on another tool. 
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allows the editing of drawings after they have been placed into Word. 
To select a drawing in Word, first click on the drawing to show it 
border. Then drag the cursor along the top left on the inside of the 
border until a black line is visible on the left edge as shown in the 
image. Either press Edit then Copy or right click on the black line and 
press Copy. The drawing can now be pasted into EASIGraph using 
this command. Note that the preferred method of moving a 
EASIGraph drawing from Word to EASIGraph is to drag it there. 

Paste  

This command is found in the File Menu. 

The tool performs the same function as the Paste Tool (found in 
Editing Tools). It is used to replace the objects in the drawing 
window with those stored on the Windows clipboard. 

Path Objects  

Path objects consist of lines, circles, circular arcs, ellipses, elliptical 
arcs, polygons, and freehand drawings. 

 Perpendicular Bisector Tool  

 

Select the desired properties for the perpendicular bisector. Click on 
each endpoint of the segment to be bisected. Move the cursor to select 
the length and orientation of the bisector and click. 
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 Parametric Graph  

 

This tool plots a parametric graph. The Width and Height Fields are 
set automatically and rarely need to be changed. The position of the 
graph in the graphing window is set by the program and cannot be 
changed. However, the graph can be Moved, Rotated, or Resized 
once it has been plotted. 

The most important fields to set are the functions field, the User 
Units, and the Axes values. 

For more information about setting properties for this tool, see: 
Graph Size, x(t) and y(t), Line Width , Color, Units Options, Scale 
Like Selected, Color Picker, Apply . 

 Paste Tool  

This tool is used to replace the objects in the drawing window with 
those stored on the Windows clipboard. Objects can be placed on the 
Windows clipboard by using the Cut or Copy command. They can 
also be copied from a drawing in Word. 

A Word drawing that was made with EASIGraph can be 
copied to the clipboard and Pasted using this command. Note that 
earlier versions of EASIGraph are converted to EASIGraph 4 but 
some minor differences may occur. This is a powerful feature that 
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Auto Scale  

 

Autoscale attempts to set the User Units of a graph so that a 
representative portion of the graph is drawn. Since there is no way of 
determining a best view, some choices are made randomly. Thus, 
repeatedly pressing the Autoscale button results in different views of 
the graph. Note that Autoscale is available only for rectangular 
graphs. 

Axes Frame  

 

Applies To: Implicit Graph Tool , Parametric Graph Tool, Polar 
Graph Tool, Rectangular Graph Tool 

This tool draws an x and/or y axis on the graph. For more information 
about setting properties for this tool, see: Axis Width , Arrows, Axis 
Color, Label Color, Grid , Font Name, Font Size, Axes Options, 
Color Picker. 

Axes Options  
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Applies To the Axes Frame of: Implicit Graph Tool , Parametric 
Graph Tool, Polar Graph Tool, Rectangular Graph Tool 

Check the x and/or y checkbox to insert the corresponding axis into 
the graph. To show units on the axes, type numbers into the Major 
and Minor Tick boxes. These numbers must be within the domain for 
the graph. The major ticks are thicker and longer than the minor ticks 
and all are drawn perpendicular to the axis. The tick color boxes are 
set the same way as any other color box (See Color for an example) 
and determine the color of the tick marks. If either of the label boxes 
is checked, then the values of the Major Ticks are labeled. Note that 
some may not be labeled in order to space the labels and those chosen 
is totally under the control of the program. If the Same button is 
clicked, then all of the y values are set the same as the x values. 

Axis Color  

 

Applies To the Axes Frame of: Implicit Graph Tool , Parametric 
Graph Tool, Polar Graph Tool, Rectangular Graph Tool 

This box sets the color that is used to draw the axis. 

There are two ways to set a color property. The first is to click on the 
color box, and the Choose Color Tool is displayed. The second way 
is click the Color Picker Tool. After a color is chosen from anywhere 
on the screen, the color can be dropped to a color box by clicking on 
the color box. If the a color box is right clicked, then the color is 
dropped but the program remains in the drop mode to set more color 
boxes. 

Axis Width   

 

Applies To the Axes Frame of: Implicit Graph Tool , Parametric 
Graph Tool, Polar Graph Tool, Rectangular Graph Tool 
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Parallelogram Options  

 

Applies To: Parallelogram Tool 

Choose one of the options of Ordinary, Rectangle, Square, or 
Rhombus. For all four options, click on two consecutive vertices and 
then move the cursor until the desired figure is drawn. Click again to 
accept the figure. 

 Parallelogram Tool  

 

Set the desired properties for the Parallelogram. The way that a 
parallelogram is drawn depends primarily on the Parallelogram 
Options setting. See that tool for more information. 

For more information about setting properties for this tool, see: 
Parallelogram, Line Width , Dotted, Snap, Auto Label, Font 
Name, Font Size, Constrain, Fill , Checkerboard, Color, Color 
Picker. 
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Clicking the menu item toggles the check mark. If checked, then the 
graphing window stays on top of other forms. 

Open Profile  

This command is found in the Edit Menu. 

The command opens a profile stored with the Save Profile command. 
Profiles save tool settings and defaults. See Save Profile for more 
information. 

Open  

This command is found in the File Menu. 

The command opens a drawing that was saved with the Save 
Command. 

 Parallel Tool  

 

This tool draws a parallel to a given line through a given point. Set the 
desired properties for the parallel line. Click on two points on the 
given line. Click on the point not on the line. Move the mouse to 
choose the starting point for the line and click. Move to select the 
ending point for the line and click 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Start Arrow , End Arrow , Snap, Color, Color 
Picker. 
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This slider determines the thickness that the axis is drawn. Since there 
is far more variety possible on the printer than there is on the screen, 
some consecutive values make no apparent difference on the screen 
but do appear different when printed. 

Capture PPT Defaults  

This command is found in the Edit Menu. 

The menu item is enabled only if a Powerpoint presentation is open 
and ready for editing. Click this menu item and the current color, line, 
and fill attributes of EASIGraph are set to those of the current 
Powerpoint presentation. The paper color is set to the background 
color of the presentation. 

 

Checkerboard  

 

Applies To: Parallelogram Tool, Polygon Tool, Trapezoid Tool. 

Checkerboard is available only for quadrilaterals. If the box is 
checked, then a checkerboard pattern fills the current drawing object. 
The colors alternate between the two colors given and the number of 
parallelograms in each direction is given in the text boxes. For more 
information on setting colors, see the Color Tool. If Checkerboard is 
checked, then Fill is ignored. 
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Choose Color Tool  

 

Select a family of colors by clicking an option button on the left. Then 
click on the color on the right. The RGB (red, green, blue) value of 
the color is shown. A color can also be selected by setting the RGB 
values. If Invisible is enabled and checked, the color is set to 
invisible. Any object with its color set to invisible is displayed in the 
drawing window but is not displayed when the object is dragged or 
pasted to Word. Invisible objects are used for reference lines. 

 Circle Given Two Tangents 
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handles can be moved independently to make abrupt changes 
in the shape of the curve. 

For more information about setting properties for this tool, see: 
Extend, Snap To Objects setting. 

Number of Hatches  

 

Applies To: Angle Hatching Tool, Line Hatching Tool. 

Depending on its context, this box determines either the number of 
linear hatch marks to be placed on a line segment or the number of 
angular hatch marks to be placed in an angle. 

Number of Segments  

 

Applies To: Split Segment Tool 

This value is used by the Split Segment Tool to determine the number 
of equal parts in which to break a segment. For example, if the 
number is 2, the segment is bisected and if 3 it is trisected. 

Number of Sides  

 

Applies To: Polygon Tool, Star Tool 

The Sides box determines the number of sides for a regular polygon 
or the number of points for a star. 

On Top  

This command is found in the Edit Menu. 
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 Node Tool  

 

When the node tool is depressed the cursor changes to a . When the 
cursor is over a snap point, it changes to a . Nodes exist for line 
segments, polygons, and freehand drawings. The Node Tool applies 
only to objects with nodes that have been selected. Nodes are 
displayed in the drawing window as small red dots. This tool performs 
differently depending on the type of object selected. 

·  Line Segment -- The nodes for a line segment are the two 
endpoints. Either of the endpoints can be dragged. If the 
Extend box is checked then the endpoints can be dragged 
only in the direction of the line segment. That is; the line 
segment can be lengthened or shortened but the direction 
cannot be changed. 

·  Polygon -- For a polygon the nodes are at the vertices. The 
shape of the polygon can be changed by dragging any of the 
vertices. Note that the Extend box has no effect for a 
polygon. 

·  Freehand Drawing -- The nodes for a freehand object are the 
points that were plotted when the object was drawn. Any of 
these nodes can be dragged to change the shape. However, the 
real power of a freehand object requires a right click on a 
node. Two red square handles appear. Dragging them changes 
the shape of the object around the node without changing the 
location of the node. If a node is right clicked a second time, a 
menu appears that adds or deletes nodes. It also allows a node 
to be made sharp. If a node is sharp, then the two red square 
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This tool draws circles tangent to two given intersecting lines.  
Choose the properties for the desired circle.  Click on the point 
of intersection of the two tangent lines.  Then click in counter-
clockwise order on another point on each of the tangent lines.  
Move the cursor and click to choose the desired circle. 

For more information about setting properties for this tool, see 
the following:  Line Width , Dotted, Snap, Fill , Color, Color 
Picker. 

Circle Tools  

 

·  Three Point Circle Tool 
·  Inscribed Circle Tool 
·  Circle Tangent Tool 
·  Circle Given Two Tangents Tool 
·  Mutually Tangent Circles Tool 
·  Point to Circle Tangents Tool 
·  Two Circles External Tangents Tool 
·  Two Circles Internal Tangents Tool 
·   

 Circle Tool  
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Set the desired properties for the circle. Click on the center in the 
drawing window. Move the cursor to a second point and click on it. 
The circle is drawn through the second point. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Snap, Fixed Length, Fill , Color, Color Picker. 

 Circular Arc Tool   

 

Set the desired properties for the arc. Click on the center in the 
drawing window. Move the cursor to a second point and click on it. 
An arc is formed with its center at the first point, its radius the 
distance between the two points, and the second point being on the 
leading edge. Move the cursor to choose the arc and click. The arc is 
drawn counterclockwise from the first point unless the Clockwise box 
is checked. If the Make Sector box is checked the endpoints of the 
arc are joined to the center point to form a sector. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Snap, Fixed Length, Constrain, Clockwise, Make 
Sector, Fill , Color, Color Picker. 

 Clear All Tool   

This tool deletes all objects from the drawing window. The shortcut 
combination Ctrl Delete performs the same function. 
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If the Constrain box is checked, then the object can be moved only 
along a ray emanating from the anchor point and at an angle that is a 
multiple of the given angle as measured from the positive horizontal. 

If this tool is active, Selected objects can be moved with the 
keyboard. Pressing any of the four arrow keys on the keyboard moves 
all of the selected objects in the direction of the arrow. 

 Mutually Tangent Circles 

 

Between one and three circles must be selected in the drawing 
window.  Select the desired properties for the circle to be drawn.  
Move the cursor in the drawing window to form a circle with the 
desired properties mutually tangent to the selected circles.  When the 
desired circle is displayed, click in the drawing window to choose it.  
It a circle is drawn mutually tangent to three circles, then at most one 
circle is possible.  Either click in the drawing window or press Apply 
to choose it. 

For more information about setting properties for this tool, click see 
the following:  Line Width , Dotted, Snap, Fixed Length, Fill , 
Color, Color Picker. 
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time to update the drawings. Increase the 
value if you have a fast computer. 

Snap Distance If this value is increased then points farther 
away from a snap point still snap to the 
snap point. 

Crop Margin Increasing this value increases the amount 
of white space left around a drawing when 
it is cropped or when Auto Crop is active. 

Blink Time Changing this value changes the rate at 
which selected objects blink. 

 Move Tool  

 

This tool moves one or more objects in the drawing window. Objects 
do not have to be selected to be moved, however if a selected object is 
moved, all selected objects are moved. When the tool is chosen, the 
cursor changes to a hand . To move an object the cursor must be 
placed directly over the object. When the cursor is directly over an 
object it changes to this shape . Click on the object to move it. The 
point clicked on is called the anchor point. As the cursor is moved, the 
object (or objects if more than one is selected) moves with the cursor. 
When the object is at the desired location, click to place it. 

When the cursor is over a snap point, it changes to this shape . If 
Snap to Objects is checked, it causes the anchor to be placed exactly 
at the snap point. Note that the cursor changes over a snap point even 
if Snap to Objects is not checked. 
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Clockwise  

 

Applies To: Angle Bisector Tool, Angle Hatching Tool, Circular 
Arc Tool. 

Normally arcs are drawn counterclockwise from the first ray to the 
second ray. If this box is checked, then they are drawn clockwise. 

Close Figure  

 

Applies To: Freehand Tool. 

If checked then a segment is added to the current freehand drawing 
joining the last node to the first node. 

Color Picker  

 

When the Color Picker Tool is clicked, the cursor changes to a 
dropper. As it is moved around the screen, a box in the upper left 
corner of the screen changes to the color that the dropper is over. 
When the mouse is clicked, that color is picked up. Move the cursor 
over any color box and click again. The color box is changed to the 
color picked up. To set more than one color box to the same color, 
right click on the color box and the program stays in the Color Picker 
mode. If the ESC button is pressed, the program returns to normal 
mode. 

Color  
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Applies To: 3 Point Circle Tool, Angle Bisector Tool, Angle From 
Tool, Angle Hatching Tool, Angle Measure Tool, Angle To Tool, 
Circle Tool, Circular Arc Tool , Dimension Tool, Drop 
Perpendicular Tool, Ellipse Tool, Elliptical Arc Tool , External 
Tangents Tool, Find Intersection Tool, Freehand Tool, Inscribed 
Circle Tool, Internal Tangents Tool, Line Tool, Line Hatching 
Tool, Make Region Tool, Parallelogram Tool, Perpendicular 
Bisector Tool, Plot Points, Point Tool, Polygon Tool, Right Angle 
Hatching Tool, Split Segment Tool, Star Tool, Tangents Tool, 
Trapezoid Tool, Triangle Tool. 

This box sets the color of the current object. If the Apply To All  
menu item is checked, then the new setting applies to all objects with 
a Color property. 

There are two ways to set the Color property. The first is to click on 
the color to display the Choose Color Tool. The second way is to 
click the Color Picker Tool. After a color is chosen from anywhere 
on the screen, the color can be dropped to the color box by clicking 
the box. If the color box is right clicked, then the color is dropped but 
the program remains in the drop mode so that more color boxes can 
be set. 

Constrain  

 

Applies To: Circular Arc Tool , Elliptical Arc Tool , Line Tool, 
Move Tool, Parallelogram Tool, Polygon Tool, Rotate Tool, Star 
Tool, Trapezoid Tool, Triangle Tool. 

Many tools require the drawing of lines or reference lines. Normally 
these lines can be drawn at any angle. However, if the constrain box is 
checked then the angle the line makes from the first plotted point to 
the second plotted point as measured counterclockwise from the 
horizontal to the right is rounded to a multiple of the value given in 
the constrain box. 
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 sqr square root 
 squ square 
 abs absolute value 
 cub cube 
 cbr cube root 
 sinh hyperbolic sine 
 cosh hyperbolic cosine 
 tanh hyperbolic tangent 
 coth hyperbolic cotangent 
 sech hyperbolic secant 
 csch hyperbolic cosecant 

Miscellaneous Defaults  

 

This command is found in the Set Defaults submenu of the Edit 
Menu. 

This window is displayed when the Set Defaults menu item is clicked. 
It can be used to change the following: 

Hilight Color This option sets the color used to select 
objects. 

Mouse Over Color This option sets the color of any object 
under the cursor when the Select Tool is 
active. 

Number Undos Moving this slider to the right makes more 
Undo levels available. 

Graph incs. Moving this value to the right makes curves 
look smoother. However, it also takes more 
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Mathematical Expressions  

Mathematical expressions are entered into the function values for a 
graph. They can also be entered into the fields for the User Units and 
Axes Tick Units. 

Any variable other than the independent variable(s) and the symbols 
pi and e is set equal to 0. When two quantities are placed next to each 
other, the operation is assumed to be multiplication. So, for example, 
3x + 4 means to multiply the value in x by 3 and add 4 and 4pi+e 
means 4 times 3.14159 + 2.71828. The standard operations of +, -, *, / 
and ^ can be used in any order. Parentheses can be nested to any level 
but there must always be a right parenthesis for each left parenthesis 
or unforeseen values may result. All spaces and capitalization are 
ignored so there is no difference between sinx and Sin X. The 
arguments for any trig function are assumed to be in radians. 

The following functions can be used in expressions: 

  Function Meaning 
 sin sine 
 cos cosine 
 tan tangent 
 cot cotangent 
 sec secant 
 csc cosecant 
 asin arc sine 
 acos arc cosine 
 atan arc tangent 
 acot arc cotangent 
 asec arcsecant 
 acsc arc cosecant 
 log log base 10 
 ln log base e 

 exp exponential (ex) 

 Page 38 

Constrain can be temporarily implemented from the keyboard by 
pressing the Ctrl key. While the key is down, the tool behaves as if the 
Constrain box is checked. 

 Copy Tool  

This tool places a copy of all objects in the drawing window on the 
Windows clipboard. The clipboard copy can be pasted into the 
EASIGraph window or into a Word document. This gives a method of 
moving drawings into Word; however, the preferred method is to 
drag the drawing into Word. 

Copy  

This command is found in the File Menu. 

The tool performs the same function as the Copy Tool (found in 
Editing Tools). It places a copy of all objects in the drawing window 
on the Windows clipboard. The clipboard copy can be pasted into the 
EASIGraph window or into a Word document. 

 Crop Tool  

When a drawing is pasted or dragged into Word, it has the same size 
as the drawing window. The result is unnecessary white space in the 
Word document. This tool crops the drawing so that a uniform 
amount of space is placed around the drawing. 

When this tool is selected, the drawing is moved and a red border is 
drawn to show how it will look when cropped. If Apply is pressed the 
drawing is cropped; otherwise, the drawing returns to its previous 
state when any other tool is selected. 

It is suggested that Auto Crop be turned on in the File Menu and 
then all cropping occurs automatically. 
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 Cut Tool  

This tool deletes all objects from the drawing window and places a 
copy on the Windows clipboard. The clipboard copy can be pasted 
into the EASIGraph window or into a Word document. Note that the 
preferred method of moving a drawing to Microsoft Word is to drag 
it there. 

Decimal Places  

 

Applies To: Angle Measure Tool, Dimension Tool. 

This box is enabled only if Use Actual Size is checked. It gives the 
number of decimal places used to measure the line segment or angle. 
Line segments are measured in centimeters or inches depending on 
the Units setting and angles are measured in degrees. 

 Delete Tool  

This tool deletes all selected objects from the drawing window. 

 Dimension Tool  

 

This tool dimensions a line segment. The dimension can be the length 
of the segment, the name of the segment, or any label. The 
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any node after the first is selected, a path is constructed from the 
previous node. If there is only one path from the previous node it is 
chosen and the current path is show in red. If more than one path 
exists from the previous node, they are all displayed in different 

colors as shown in the figure  and the program waits for one 
of the paths to be clicked. When the first node is selected a second 
time the region is created. Note that the selection can be aborted by 
pressing the ESC button. 

For more information about setting properties for this tool, see: Line 
Width , Fill , Color, Region Options, Color Picker. 

Make Sector  

 

Applies To: Circular Arc Tool , Elliptical Arc Tool . 

If an arc is drawn and this box is checked, then segments are added 
from the endpoints of the arc to the center of the circle or ellipse to 
form a sector. 

Map Colors  

This command is found in the Edit Menu. 

All of the colors in the current drawing are shown in a 
new form. Any of the colors in the ‘To’ column can be changed by 
clicking on them. When OK is clicked then all colors in the current 
drawing are changed from the ‘From’ value to the ‘To’ value. 
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This slider determines the thickness that lines and paths are drawn. It 
applies to graphs, path objects, and hatch marks. Since there is far 
more variety possible on the printer than on the screen, some 
consecutive values make no apparent difference on the screen. They 
are different when printed. 

If the Apply To All  menu item is checked, then the new setting 
applies to all objects with a Line Width property. 

 Make Region Tool  

 

Regions are closed paths. That is; they are paths that start and end at 
the same point. When two or more paths are drawn, they sometimes 
intersect to form one or more regions. This tool creates a new object 
from a region formed by two or more intersecting paths. Usually the 
Fill box is checked so that a solid colored region is created. The way 
the tool is implemented depends primarily on whether the Manual box 
is checked. 

If the Manual box is not checked, then the tool will attempt to create a 
region automatically. Since the same set of paths might create several 
different regions, the tool has to make its best guess as to which 
region is desired. Different regions may be chosen if different values 
are given in the Region Options fields. 

If the Manual box is not checked, then all of the points of intersection 
of all selected paths are shown. These nodes are clicked on in either 
clockwise or counterclockwise order to form a region. The current 
node, if one has been selected, is shown with a small blue x. When 
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implementation of the tool varies depending on whether the Use 
Actual Size box or Simple Label box is checked. 

If Use Actual Size is checked then: 

Set the desired properties for the dimension information. In 
particular set the Show Units box and Decimals box. Click on 
each endpoint of the segment to be dimensioned. Move the cursor 
to change the placement of the dimension segment and click. The 
segment is dimensioned with its actual length in inches or 
centimeters depending on the setting of Units. The dimension 
information is placed either parallel to the segment, vertically, or 
horizontally depending on if the Dimension Options is set to 
Slant, Vertical or Horizontal. If the Show Units box is checked, 
either in (for inches) or cm (for centimeter) is attached to the 
length of the segment in the dimension. The Decimals setting 
gives the number of decimal places used to measure the length. 

If Simple Label is checked then: 

Type a label in the Simple Label text box. That label is used 
for the dimension information. The dimension can be made 
Bold, Italic or both by clicking the B or I checkboxes. This 
method is not as flexible as the next method, however; it does 
allow the entry of special symbols. If any of the keywords 
[alpha], [beta], [degree], [delta], [epsilon], [gamma], [mu], 
[phi], [pi], [rho], [sigma], or [theta] is found in the text then it 
is replace with the corresponding Greek letter or symbol. 

If neither Use Actual Size nor Simple Label is checked then: 

Type a label to be placed in the dimension information. This is 
usually a single letter. Select the label (and nothing else). 
Activate this tool and set the desired properties for the 
dimension information. Click on each endpoint of the segment 
to be dimensioned. The selected label moves so that it is the 
dimension information for the line segment. Move the cursor to 
change the placement of the dimension segment and click. The 
dimension information is placed either parallel to the segment, 
vertically, or horizontally depending if the Dimension Options 
is set to Slant, Vertical or Horizontal. 
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For more information about setting properties for this tool, see: Snap, 
Line Width , Simple Label, Use Actual Size, Units, Font Name, 
Font Size, Color, Color Picker. 

Dot Top  

 

Applies To: Ellipse Tool 

When Half Dotted is checked, either the top half or the bottom half of 
the ellipse is drawn as a dotted line. The other half is drawn solid. 
This box determines which half is dotted. Half dotted ellipses are 
usually used in 3D drawings to give the illusion of circles. 

Dotted  

 

Applies To: 3 Point Circle Tool, Angle Bisector Tool, Angle From 
Tool, Angle To Tool, Circle Tool, Circular Arc Tool , Drop 
Perpendicular Tool, Ellipse Tool, Elliptical Arc Tool , External 
Tangents Tool, Freehand Tool, Inscribed Circle Tool, Internal 
Tangents Tool, Line Tool, Parallelogram Tool, Perpendicular 
Bisector Tool, Polygon Tool, Star Tool, Tangents Tool, Trapezoid 
Tool, Triangle Tool. 

If checked then the current line or path is drawn dotted. 

Dragging  

The preferred method for moving EASIGraph drawings to and from 
Microsoft Word is to drag them. 

To drag a drawing from EASIGraph into Word, first deselect any tool 
on the top row in the tools window. If any tool is selected then mouse 
clicks in the drawing window are assumed to apply to that tool and 
dragging is not implemented. Make sure the Word document is open 
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·  Plot Angle Bisector 
·  Plot Perpendicular Bisector 
·  Plot Angle From a Line Segment 
·  Plot Angle To a Line Segment 

 Line Tool  

 

Set the desired properties for the line segment. Click on any point in 
the drawing window. Move the cursor to a second point and click. A 
segment is drawn between the two points. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Start Arrow , End Arrow , Snap, Constrain, Fixed 
Length, Color, Color Picker. 

Line Width   

 

Applies To: 3 Point Circle Tool, Angle Bisector Tool, Angle From 
Tool, Angle Hatching Tool, Angle To Tool, Circle Tool, Circular 
Arc Tool, Dimension Tool, Drop Perpendicular Tool, Ellipse Tool, 
Elliptical Arc Tool , External Tangents Tool, Freehand Tool, 
Inscribed Circle Tool, Internal Tangents Tool, Line Tool, Line 
Hatching Tool, Make Region Tool, Parallelogram Tool, 
Perpendicular Bisector Tool, Polygon Tool, Right Angle Hatching 
Tool, Split Segment Tool, Star Tool, Tangents Tool, Trapezoid 
Tool, Triangle Tool. 
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 Line Hatching Tool  

 

Set the desired properties for the hatch marks. Click on each of the 
endpoints of a line segment in the drawing window. Hatch marks are 
drawn perpendicular to the segment. The primary purpose of hatch 
marks is to mark two segments as congruent. 

For more information about setting properties for this tool, see: Line 
Width , Snap, Hatch Size, Number of Hatches, Color, Color 
Picker. 

Line To Angle  

 

Applies To: Angle From Tool, Angle To Tool 

This box gives the size in degrees of the angle that a ray makes with a 
base line. 

Line Tools  

 

·  Drop a Perpendicular 
·  Draw Parallel Line 
·  Split a Line Segment Into Equal Parts 
·  Find Path Intersection Points 
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to the location where the drawing is to be placed. Drag from any point 
in the drawing window to the desired location in Word. Note that the 
drawing is normally placed in Word with the same size as the drawing 
window. This can lead to large amounts of empty space in the Word 
document. It is suggested that you either crop the drawing in 
EASIGraph before dragging it to Word or make sure Auto Crop is 
checked so that EASIGraph automatically crops the drawing. 

To drag a drawing created with EASIGraph from Word to 
EASIGraph, click on the drawing to make the border visible. Drag the 
cursor along the top left on the inside of the border until a black line is 
visible on the left edge as shown in the drawing. Drag this black line 
to the drawing window of EASIGraph. Note that earlier versions of 
EASIGraph are automatically converted to EASIGraph 4; however, 
some minor differences may occur. 

 Draw Tangent Tool  

 

Select a circle. Select the desired properties for the tangent line. Move 
the cursor and click to pick the point of tangency. Move the cursor 
and click to choose the starting point of the tangent line. Move the 
cursor and click to choose the end of the tangent line.  

For more information about setting properties for this tool, see: Line 
Width , Dotted, Start Arrow , End Arrow , Snap, Color, Color 
Picker. 
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Draw Tools  

 

·  Draw Lines 
·  Draw Circles 
·  Draw Circular Arcs  
·  Plot Points 
·  Draw Triangles 
·  Draw Parallelograms 
·  Draw Trapezoids 
·  Draw Ellipses 
·  Draw Elliptical Arcs  
·  Draw Polygons 
·  Draw Stars 
·  Make Freehand Drawings 

 Drop Perpendicular Tool  

 

Select the desired properties for the perpendicular segment. Click on 
any point in the drawing window. Click on two points on a segment. 
The perpendicular is drawn from the point to the segment. Note that if 
necessary the perpendicular is drawn to the extended line segment. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Start Arrow , End Arrow , Snap, Extend By, Color, 
Color Picker. 
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If this box is checked when a 3 point circle is drawn, the three points 
used to determine the circle are also plotted. 

Key Defaults  

 

This command is found in the Set Defaults submenu of the Edit 
Menu. 

When the Text Tool is active and the Math Button  is depressed, 
various mathematical functions and keys are available. This window 
changes the keys that are available. Check the ones desired. The 
Columns slider gives the number of columns used to display the keys. 

Label Color  

 

Applies To the Axes Frame of: Implicit Graph Tool , Parametric 
Graph Tool, Polar Graph Tool, Rectangular Graph Tool 

There are two ways to set the Color property. The first is to click on 
the color to display the Choose Color Tool. The second way is to 
click the Color Picker Tool. After a color is chosen from anywhere 
on the screen, the color can be dropped to the color box by clicking 
the box. If the box is right clicked, then the color is dropped but the 
program remains in the drop mode so that more color boxes can be 
set. 
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 Internal Tangents Tool  

 

Select two circles in the drawing window. Check the desired 
properties for the tangents. Two internal tangent lines are drawn to the 
two circles. Click the Apply  button to make the tangent lines a 
permanent part of the drawing. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Start Arrow , End Arrow , Color, Color Picker. 

Isosceles Trapezoid  

 

Applies To: Trapezoid Tool 

This box determines whether the trapezoid being drawn is isosceles. If 
the box is checked, three points must be clicked in the drawing 
window to determine the trapezoid. If it is not clicked, then four 
points must be clicked. See the Trapezoid Tool for more information. 

Keep  

 

Applies To: 3 Point Circle Tool, Inscribed Circle Tool. 
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 Duplicate  

Select the tools to be duplicated.  Move the mouse and click to place 
the duplicates in the graphing window.  The shortcut combination Ctrl 
D places a duplicate of the selected objects a quarter of an inch to the 
right and below the original objects. 

Edit Menu   

 

For information about each of these menu items, see one of the 
following: Open Profile, Save Profile, Set Defaults, Capture PPT 
Defaults, Map Colors, On Top, Apply To All  

Edit Tools  

 

·  Cut Tool 
·  Copy Tool 
·  Paste Tool 
·  Zoom Tool 
·  Crop Tool 
·  Delete Tool 
·  Clear All Tool 
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 Ellipse Tool  

 

Set the desired properties for the ellipse. Click on the center of the 
ellipse. Move the cursor to choose the shape of the ellipse and click. 
Note that all ellipses are drawn with their major axis either horizontal 
or vertical. However, once drawn an ellipse can be rotated to any 
angle. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Half Dotted, Dot Top, Snap, Fill , Color, Color 
Picker. 

 Elliptical Arc Tool   

 

Set the desired properties for the elliptical arc. Draw the reference 
ellipse by clicking on the center and then moving the cursor until the 
desired ellipse is formed. Click to select the ellipse. Move the cursor 
to choose the leading edge of the arc and click. Finally move the 
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Right clicking on an object opens a menu allowing objects to be 
deleted or renamed.  Objects can also be dragged from one folder to 
another. 

Independent Variable  

 

Applies To: Plot Points 

The value entered sets the independent variable. For either Polar or 
Parametric Graphs, the independent variable is t instead of x. The 
variable is evaluated for the function of the selected graph and the 
resulting point is plotted on the graph. 

 Inscribed Circle Tool  

 

Select the desired properties for the circle. Click on three points in the 
drawing window one at a time. The circle inscribed in the triangle 
with these three points at the vertices is drawn. 

For more information about setting properties for this tool, see: Plot 
Center Only, Line Width , Dotted, Snap, Fill , Keep, Color, Color 
Picker. 
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but not yet applied, the background of the tool frame changes to this 
color . 

Several graphs can be overlapped. This not only allows multiple 
graphs on the same axes, but allows the graphing of piecewise defined 
functions. The best way to do this is to add the axes and user unit 
information to one graph and select it. Then for each additional graph, 
check the Scale Like Selected box. 

For more information about setting properties for this tool, see: 
Graph Size, f(x, y), Line Width , Color, Units Options, Scale Like 
Selected, Color Picker, Apply . 

Import  Object 

This command is found in the File Menu. 

While most shapes can be drawn quickly with EASIGraph, some 
complex shapes, particularly 3D shapes, can take a few minutes. 
EASIGraph ships with several of these objects. In addition your own 
objects can be exported by using the Export Objects command under 
the Export  sub menu of the File Menu. This command imports these 
objects into a drawing. To allow for flexibility, an imported object 
may consists of many separate objects. They are all selected. To treat 
all of the selection as one object, group the selection by pressing the 
F5 button or the Group button under the Select Tool. 

When the Import menu item is clicked, a window opens giving folders 
containing thumbnails of available objects. Either double click on any 
item to import it or drag it to the drawing window. 

Right clicking on any of the folder names opens a menu.  The menu 
provides for renaming, deleting, and inserting new folders.  There is 
also a command to Create a Collection.  This command creates an 
EASIWord collection file (ewc) containing information about all 
objects in the folder clicked on and all of its sub-folders.  This ewc 
file can be shared with others to give them copies of all of these 
objects.  The collection can be retrieved using the Retrieve 
Collection menu item in the File Menu. 
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cursor to choose the terminating edge of the arc and click. The arc is 
drawn counterclockwise from the leading edge to the terminating 
edge. Note that all elliptical arcs are drawn with their major axis 
either horizontal or vertical. However, once drawn the arc can be 
rotated to any angle. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Snap, Constrain, Make Sector, Fill , Color, Color 
Picker. 

End Arrow   

 

Applies To: Angle Bisector Tool, Angle From Tool, Angle To Tool, 
Drop Perpendicular Tool, External Tangents Tool, Freehand 
Tool, Internal Tangents Tool, Line Tool, Perpendicular Bisector 
Tool, Tangents Tool. 

If checked then an arrow head is placed on the end of the current line 
or path. 

Export As bmp  

This command is found in the Export  sub menu of the File Menu. 

Clicking the command places a copy of the drawing window onto the 
Clipboard in bmp format. Bmp format is a standard picture format so 
the picture can be pasted into nearly any program that accepts image 
files. 

Export As Object  

This command is found in the Export  sub menu of the File Menu. 

While most shapes can be drawn very quickly with EASIGraph, some 
complex shapes, such as 3D shapes, can take a few minutes. 
EASIGraph ships with several of these objects already drawn. These 
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shapes are imported into drawings with the Import Objects menu 
item found under the File Menu. The purpose of this command is to 
add your own shapes to the database of shapes. 

Draw an object in the drawing window and click this command. A 
window is displayed showing the current objects that are available for 
importing. Type in the name for the new object in the text box at the 
upper left of the window and press the OK button. Alternatively, 
double click on an object to overwrite it. 

Export As rtf   

This command is found in the Export  sub menu of the File Menu. 

The command opens a dialog to save the current drawing as a rtf file. 
Rtf is the format used by Microsoft Office for migrating documents. 
The saved file can be read by most versions of Word. 

Export Sub Menu  

 

This sub menu is found under File Menu. 

For information about each of these submenu items, see one of the 
following: Export As Object, Export As rtf , Export As bmp, 
Export To Powerpoint 

.  

Export To Powerpoint  

This command is found in the Export  sub menu of the File Menu. 

The command places the contents of the drawing window into an 
active Powerpoint presentation. To use this command Powerpoint 
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·  Line Hatching Tool 
·  Angle Hatching Tool 
·  Right Angle Hatching Tool 

Help Menu  

The Help Menu has only one option; EASIGraph Help. This item 
displays the help file. However, there are other ways to get help. If the 
Show Help menu item is checked, then brief help messages for each 
tool are shown at the bottom of the tool window. This help is 
interactive in that changing options for the tool might change the help 
displayed. Also if any tool is active, pressing F1 displays help for the 
active tool. 

 Implicit Graph   

 

This tool plots a function of x and y equal to zero in rectangular 
coordinates. The Width and Height Fields are set automatically and 
rarely need to be changed. The position of the graph in the graphing 
window is set by the program and cannot be changed. The graph can, 
however, be Moved, Rotated, or Resized after it has been plotted. 

The most important fields to set are the function field, the User 
Units, and the Axes values. 

When changes are made, they are shown immediately in the graphing 
window. However, they do not become a permanent part of the 
drawing until the Apply  button is pressed. When changes are made 
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radii of concentric circles drawn about the origin. The Major Ticks are 
drawn thicker than the Minor Ticks. 

Grouping Objects  

When objects are grouped they behave as if they are one object. That 
is; any transformations or property changes are applied to all of 
them. To group selected objects, press the Group button in the Select 
Tool family of tools or alternatively press the F5 shortcut. A group 
can be ungrouped by pressing the Ungroup button or the F6 shortcut. 
To make the entire drawing into one group press the F2 button (to 
select all) and then the F5 button. 

Half Dotted  

 

Applies To: Ellipse Tool. 

If this box is checked, then either the top half or the bottom half 
(depending on whether the Top box is checked) is drawn as a dotted 
line. The other half is drawn solid. This tool is usually used in 3D 
drawings to give the illusion of circles. When this box is checked, 
Dotted is ignored. 

Hatch Size  

 

Applies To: Angle Hatching Tool, Line Hatching Tool, Right 
Angle Hatching Tool, Split Segment Tool. 

Changing this setting makes linear hatch marks longer or shorter or 
makes angular hatch marks farther from the vertex. 

Hatching Tools  
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must be open and a slide must be available for editing. If more than 
one instance of Powerpoint is open, then the program chooses the first 
instance opened. 

Extend By  

 

Applies To: Drop Perpendicular Tool, Perpendicular Bisector 
Tool, Tangents Tool. 

If checked for the Drop Perpendicular Tool or the Perpendicular 
Bisector Tool, then the perpendicular extends beyond the segment by 
the distance (in inches) given in the box. If checked for the Tangents 
Tool, the two tangents from the point to the circle extend beyond the 
circle by the distance given. 

Extend Line  

 

Applies To: Node Tool. 

This box is enabled only if one of the selected objects is a line 
segment. When checked and when the node tool is being applied to a 
line segment, the node can be moved only in the direction of the line 
segment (making the segment longer or shorter). 
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 External Tangents Tool  

 

Select two circles in the drawing window. Check the desired 
properties for the tangents. Two external tangents are drawn to the 
two circles. Click the Apply button to make the tangent lines a 
permanent part of the drawing. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Start Arrow , End Arrow , Color, Color Picker. 

f(x)  

 

Applies To: Rectangular Graph 

The graph of y = f(x) is plotted. Any variable other than x, pi, or e is 
set equal to 0. See Mathematical Expressions for more information 
on expressions that can be used for the function. 

f(x,y)  

 

Applies To: Implicit Graph  
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Columns slider gives the number of columns used to display the 
functions. 

Graph Size  

 

Applies To: Implicit Graph Tool , Parametric Graph Tool, Polar 
Graph Tool, Rectangular Graph Tool 

Graph Size sets the size in inches that the graph is displayed. If the 
width and height do not match, then the graph is stretched in one 
direction. This is particularly displeasing for polar graphs. The graph's 
position is automatically determined by the program. However after it 
is drawn, it can be moved, rotated, or resized. 

Graphing Tools  

 

·  Plot Rectangular Graphs 
·  Plot Polar Graphs 
·  Plot Parametric Graphs 
·  Plot Functions Defined Implicitly  
·  Plot Points on Existing Graphs 

Grid   

 

In Rectangular Graph mode, when Grid is checked a rectangular 
grid is drawn with the Major Ticks  drawn thicker than the Minor 
Ticks.  

In Polar Graph mode, when Grid is checked, a polar grid is drawn. 
The value of the text box beside the Grid tool gives an angle in 
degrees such that a ray is drawn from the origin at every multiple of 
that angle. The values of the Major and Minor ticks determine the 
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 Freehand Tool  

 

Select the desired properties for the freehand drawing. Click on 
several nodes in consecutive order to form the general shape of the 
drawing. Terminate the drawing by either right clicking on the last 
node or by pressing the END key after clicking the last node. The 
freehand drawing can be modified to a precise shape by using the 
Node Tool. 

For more information about setting properties for this tool, see: Line 
Width , Dotted, Snap, Start Arrow , End Arrow , Close Figure, Fill , 
Color, Color Picker. 

Function Defaults  

 

This command is found in the Set Defaults submenu of the Edit 
Menu. 

When the Text Tool is active and the Math Button  is depressed, 
various mathematics functions and keys are available. This window 
changes the functions that are available. Check the ones desired. The 
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The graph of f(x,y) = 0 is plotted. Any variable other than x, y, pi, or e 
is set equal to 0. See Mathematical Expressions for more 
information on expressions that can be used for the function. 

File Menu  

 

For information about each of these menu items, see one of the 
following:  Save, Open, Open Profile, Save Profile, Export , Import 
Object, Retrieve Collection, Trace Mode, Auto Crop, Show Help. 

Fill   

 

Applies To: 3 Point Circle Tool, Circle Tool, Circular Arc Tool , 
Ellipse Tool, Elliptical Arc Tool , Freehand Tool, Inscribed Circle 
Tool, Make Region Tool, Parallelogram Tool, Polygon Tool, Star 
Tool, Trapezoid Tool, Triangle Tool. 

Check the Fill box. Choose a color for the interior of the object. There 
are two ways to set a color property. The first is to click on the color 
to display the Choose Color Tool. The second way is click the Color 
Picker Tool. After a color is chosen from anywhere on the screen, the 
color can be dropped to the color box by clicking on the box. If the 
box is right clicked, then the color is dropped and the program 
remains in the drop mode to set more color boxes. 
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 Find Intersection Tool  

 

Select the desired color for the points of intersection. Select two or 
more path objects and click Apply . Points are inserted at the 
intersections of the path objects. 

For more information about setting properties for this tool, see: Color, 
Color Picker. 

Fixed Length  

 

Applies To: Angle Bisector Tool, Angle From Tool, Circle Tool, 
Circular Arc Tool , Line Tool, Perpendicular Bisector Tool, 
Polygon Tool, Star Tool. 

Tools for drawing lines, circles, and polygons normally allow 
segments to be of any length. If Fixed Length is checked and a 
number is entered in the text box, then those figures are drawn using 
the length given. 

The value in the Fixed Length text box can be set by clicking the Set 
button and clicking on two points in the drawing window. The value 
is set to the distance between the two points. The command can be 
canceled by pressing the ESC button. 
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 Flip Horizontally   

When this tool is implemented, all selected objects are mirrored 
around a vertical line through the center of all selected objects. The 
changes are not made permanent until the Apply  button is clicked. 
The shortcut combination Ctrl H performs the same function. 

 Flip Vertically   

When this tool is implemented, all selected objects are mirrored 
around a horizontal line through the center of all selected objects. The 
changes are not made permanent until the Apply  button is clicked. 
The shortcut combination Ctrl V performs the same function. 

Font Name  

 

Applies To: Angle Measure Tool, Dimension Tool, Parallelogram 
Tool, Polygon Tool, Star Tool, Trapezoid Tool, Triangle Tool and 
the Axes Frame of: Implicit Graph Tool , Parametric Graph Tool, 
Polar Graph Tool, Rectangular Graph Tool. 

This drop list includes all of the fonts currently available. 

Font Size  

 

Applies To: Angle Measure Tool, Dimension Tool, Parallelogram 
Tool, Polygon Tool, Star Tool, Trapezoid Tool, Triangle Tool and 
the Axes Frame of: Implicit Graph Tool , Parametric Graph Tool, 
Polar Graph Tool, Rectangular Graph Tool. 

Either choose a font size from the drop list or type a font size. 


